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OVERVIEW 
Scenario Analysis 123 allows users to quickly create and iterate through several what-if scenarios 
utilizing different driver-based rules in order to efficiently analyze different outcomes. The solution 
allows for the creation and management of multiple rules and execution of calculation jobs across 
scenarios. The solution includes built-in reporting capabilities to compare results across scenarios. 

Important Usage Considerations 
Following are important considerations for the implementation and usage of Scenario Analysis 123: 

Access  
Scenario Analysis 123 is not intended to be used within Workflows and must only be accessed using the 
OnePlace dashboard.  

Limit usage of Scenario Analysis 123 to the following: 

• Experienced OneStream “Power Users” 
• Administrator security role 
• Security group with a limited number of experienced “Power Users” 

Performance Impacts 
Scenario Analysis 123 is not intended for full Entity or multi-Entity hierarchy consolidations spanning 
multiple periods or years for multiple users. Calculation jobs created using Force Consolidate are 
intended for base level calculations and small consolidation hierarchies. 

The single environment shares resources between the two applications. Testing Scenario Analysis 123 in 
a single environment that includes Development and Production applications will impact both 
applications. Coordinate an optimal testing window within your organization to prevent negative impact 
on other reporting processes performed in the Production application. 
 
When copying base data from one scenario to another, it is important to understand how much data is 
being copied and whether you need to consolidate the whole Entity structure or multiple Entity 
structures. Multiple large consolidations in the system may impact each other depending on the 
environment configuration.  

Refer to the consolidation schedules of your organization before using Scenario Analysis 123. 
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SETUP & INSTALLATION 
This section contains important details related to the planning, configuring, and installation of your 
solution. Before you install Scenario Analysis 123, familiarize yourself with these details.  

See also: MarketPlace Solution Modification Considerations 

Dependencies 
Component Description 
OneStream XF 5.3.0 or later Minimum OneStream Platform version required to install this 

version of Scenario Analysis 123. 
OneStream App for Windows Scenario Analysis 123 is optimized for the OneStream App for 

Windows which has all the functionality as the browser-based 
version of OneStream XF. 

Select the Scenario Analysis 123 Development Location  
Before beginning installation, decide whether to build Scenario Analysis 123 directly in the Production 
OneStream XF application or in a separate Development OneStream XF application. This section 
provides some key considerations for each option.  

Production OneStream XF Application: The primary advantage of building Scenario Analysis 123 in a 
Production application is that you will not have to migrate the resulting work from a Development 
application. However, there are intrinsic risks when making design changes to an application that is 
being used in a Production capacity and this is seldom advised.  

 
Note: It is strongly recommended to implement Scenario Analysis 123 in the Development 
environment with a fresh copy of the Production application before starting work.  

Development OneStream XF Application: As a Best Practice, use the Development OneStream XF 
application to build Scenario Analysis 123.  

Create the OneStream XF Development Application 
1. Ensure all the OneStream XF artifacts relating to Scenario Analysis 123 such as Scenarios are in 

the Production application. 
2. Copy your Production OneStream XF application to your Development environment and rename 

it. This Development version will be used for your Scenario Analysis 123 project.  
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Application Server Settings 
You may need to edit the OneStream XF Application Server Configuration so users can create and 
change data in the additional database tables used by Scenario Analysis 123. If other MarketPlace 
Solutions (such as Specialty Planning) are already in the application, these adjustments may already 
exist. 

See also: Solution Database Migration Advice 

Configure the OneStream XF Application Server 
Be sure that the security group settings include the users who will be working on and setting up Scenario 
Analysis 123 before proceeding. 

 
Note: Group settings are applicable to all XF MarketPlace solutions; it is important to keep 
the group names generic.  

1. Start the OneStream XF Server Configuration Utility as an Administrator.  
2. Select Open Application Server Configuration File > Database 
3. Edit the following OneStream Database Server properties: 

• Access Group for Ancillary Tables: Select a group that includes those who will access 
records. 

• Can Create Ancillary Tables: True 
• Can Edit Ancillary Table Data: True 
• Maintenance Group for Ancillary Tables: Select a group who will edit and maintain tables. 
• Table Creation Group for Ancillary Tables: Select a group who can create tables.  

 

4. Restart Internet Information Server. 
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Install Scenario Analysis 123 
1. On the OneStream XF MarketPlace Dashboard, click MarketPlace > Scenario Analysis 123. 

 

2. On the Scenario Analysis 123 Solution page, select the appropriate OneStream XF platform 
version from the Minimum Platform Version drop-down list.  

3. Select the most recent version from the Solution Version drop-down list and then click 
Download. 

4. Log in to OneStream XF. 
5. On the Application tab, click Tools > Load/Extract.  
6. On the Load tab, locate the solution package using the Select File icons and click Open. 
7. When the solution’s file name appears, click Load.  
8. Click Close to complete the installation.  

Set Up Scenario Analysis 123 
The first time Scenario Analysis 123 is run, you are guided through the table setup process. 

• In OneStream XF, click OnePlace > Dashboards > Scenario Analysis 123 > Scenario Analysis 123. 
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Create Tables 
1. Click Step 1: Create Tables 

This step may be necessary when upgrading even if tables are already present. Scenario Analysis 
123 will not drop any tables that already exist but will modify table structures and add any new 
ones if necessary. 

 

2. When setup is complete, click Step 2: Launch Solution to open Scenario Analysis 123. 

Package Contents 
The Dashboard Maintenance Unit provides the user interface for Scenario Analysis 123 and includes the 
required Dashboard Groups, Components, Data Adapters, Parameters and files.  
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HOME 

 
The Home page contains Setup, Execute, and Analyze. 

Scenario Analysis 123 is grouped into three sections: 

1. Setup establishes the creation and maintenance of scenario Definitions, Rule Sets, and Rules. 
2. Execute contains execution and management of Calculation Jobs for scenario Definitions. 
3. Analyze displays charts and pivot grids to view different scenario results. 
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SETTINGS  

 
The Settings page contains the Global Options tab in which key properties that guide Scenario 
Analysis 123 administration are set as well as Uninstall options.  

Global Options 
The Global Options page should be one of the first pages visited when configuring Scenario Analysis 
123. 

 
Note: All Global Options settings are retained during solution upgrades.  

 

 

Access and Manage Scenario Analysis Security Role 
Scenario Analysis 123 security is governed at the global level. Therefore, it is the assignment of the user 
group to the Security Role that determines who will be the global Scenario Analysis 123 Administrators.  

Assign User Group to Security Role 
• Click Global Options, select the user group from the drop-down list (the default value is 

Administrators), and click Save. 

Analyze Results Row Limit 
Analyze Results Row Limit sets the maximum number of data rows that can be used to display the 
charts and pivot grids on the Analyze page. The default value is 50,000 rows which can be raised or 
lowered to account for server and client hardware-based performance limitations. 
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Uninstall  
Uninstall allows the Scenario Analysis 123 User Interface or the entire solution to be uninstalled. Note 
that if this is performed as part of an upgrade, any modifications that were performed on standard 
Scenario Analysis 123 objects will be removed.  

There are two Uninstall options:  

1. Uninstall UI removes Scenario Analysis 123, including related dashboards and business rules but 
leaves the database and related tables in place. For some releases, this step should be 
performed before accepting any new version of Scenario Analysis 123 since some of the 
Dashboards or other objects may have been modified. 

• Choose this option if you want to accept a Scenario Analysis 123 update without 
removing the data tables. 

• The Scenario Analysis 123 Release Notes will indicate if an overinstall is supported. 
2. Uninstall Full removes all the related data tables, all data, Scenario Analysis 123 Dashboards, 

and Business Rules.  
• Choose this option to completely remove Scenario Analysis 123 or to perform an 

upgrade that is so significant in its changes to the data tables that this method is 
required. 

 
WARNING: Uninstall procedures are irreversible. 
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SETUP 

 
Setup includes the creation and maintenance of Definitions, Rule Sets, and Rules.  

Definitions 
Definitions consist of a Source and Target Scenario for a Cube. Rules Sets and Rules can be created and 
applied to the Definition’s Target Scenario. 

• Name: Freeform text field to give Definition a short name. 
• Description: Optional freeform text field containing additional definition information. 
• Target Scenario: The scenario to which the rules are applied. 
• Source Scenario: The scenario that will be copied to the Target Scenario. 
• Cube: The Cube where the Source and Target Scenarios are located. 
• Created By: The name of the user who created the Definition. 
• Created Date: The date the Definition was created. 

 
Note: Cube and Source Scenarios are displayed based on the user’s security access.  

 

 

 

 

Creating a new Definition will create a new Target Scenario by copying all Dimension 
Library properties and settings, including security settings, from the Source Scenario 
within the same Cube.  
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Create a Definition 

 

Tip: Selecting a Scenario Type should be considered and based on business requirements. A 
new Scenario Type can be used if your requirements do not require all financial model rules 
to be attached to that Scenario Type. 

1. On the Setup page, click Create. 
2. In the Create Definition dialog Select: 

• Definition Name: Enter a display name to identify the Definition. 
• Definition Description: Enter an optional description for the Definition. 
• Cube: Select the Cube where the Source and Target Scenarios are located. 
• Source Scenario: Select the Source Scenario that will be copied to the Target Scenario. 
• Target Scenario Type: Select the new Target Scenario type (defaults to the same type as the 

selected Source Scenario). 
• Target Scenario Name: Enter the new Target Scenario name where the rules will be applied. 
• Target Scenario Description: Enter an optional description for the new Target Scenario. 
• Copy All Rule Sets and Rules from Source: Select this checkbox to copy existing Scenario 

Analysis Definition Rule Sets and Rules if they exist for the source scenario. This will not copy 
member formulas and business rules. 

3. Click Save.  

 

Important! The settings of the Source Scenario and Target Scenario must be the same.  
Examples: Copying from a Source Scenario using Range to a Target Scenario using Yearly or 
copying Source Scenario to a Target Scenario that uses Extensibility. 
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Delete a Definition 
1. On the Setup page, select the Definition. 
2. Select Delete Row(s). 
3. Click Save.  

 

Note: Deleting a definition does not delete the Target Scenario created with the definition. 
If a scenario must be deleted, use the Dimension Library under Application. You must first 
remove that scenario with a Data Management “Clear Data” job before you can delete a 
scenario. 

Rule Sets 
Rule Sets are a collection of Rules that can be applied to the Target Scenario definition.  

• Name: Freeform text field to give Rule Set a short name. 
• Description: Optional freeform text field containing additional Rule Set information. 
• Process Sequence: The order in which the Rule Sets are run. Rule Sets are run in ascending 

order of the process sequence. 
• Active: Indicates if the Rule Set should be run during Rule processing (on/off toggle). 
• Collapse Data: Will collapse all data to the Import origin.  

 
Note: Collapse Data should be used if the scenario will be used in Cube View forms to allow 
form adjustment entry into the origins.  

Add Rule Set  
1. On the Setup page, select the Definition. 
2. Select Insert Row on the Rule Sets table header and then double-click in the following cells to 

enter information: 
• Name: Enter a display name to identify the Rule Set. 
• Description: Enter an optional description for the Rule Set. 
• Process Sequence: Enter the sequence order for Rule Set processing. 

3. Click Save.  
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Copy Rule Set  
Copying Rule Set allows for a Rule Set to be copied to the same Definition or different Definition.  

1. On the Setup page, select the Definition. 
2. Select the Rule Set you want to copy. 
3. Select Copy Set. 
4. In the Copy Rule Set dialog box, add the new Rule Set Name, an optional Rule Set Description, 

and the Target Definition. 
5. Click Copy. 

  

Delete Rule Set 
1. On the Setup page, select the Definition and Rule Set. 
2. Select Delete Row(s). 
3. Click Save. 

Rules 
Rules are a collection of percentage values tied to a specific dimension and a time range for a given 
Definition Rule Set.  

• Name: Freeform text field to give Rule a name 
• Description: Optional freeform text field containing additional Rule information 
• Process Sequence: The order in which the rules are run. Rules are run in ascending order of the 

process sequence within each Rule Set. 

 
Note: Consideration is needed for processing sequencing of rules. Rules with broader to 
more specific Member Filters should be sequenced in ascending order.  

 

• Active: Indicates if the Rule should be run during rule processing (on/off toggle) 
• Dimensions (Entity – UD8): The dimensions available where Member Filters can be applied for 

the Definition.  
• Origin: There are three options for origin: Top, BeforeAdj, and Import. 
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Note: Each dimension field is freeform and allows for Member Filters to be applied to filter 
the data. Brackets are added to all Member Filters when applied to the formula as a 
precaution in case a dimension member has a space. Example: [New York] 

 

See Chapter 7: Cube Member Filters in the OneStream XF Design and Reference Guide for complete 
Member Filter details.  

• Periods (P1-P24): Time periods 1 through 24 where the rule numerical percentage values will be 
applied.  

Add Rule  
1. On the Setup page, select the Definition and Rule Set. 
2. Select Insert Row on the Rules table header and then double-click in the following cells to enter 

information: 
• Name: Enter a display name to identify the Rule 
• Description: Enter an optional description for the Rule. 
• Process Sequence: Enter the sequence order for the rule processing. 
• Dimensions (Entity – UD8): Enter the Member Filters for each dimension. 
• Periods (P1-P24): Enter the percentage values for each period. Alternatively, the percentage 

value can be entered in the % Value field for a percentage value to be applied to all periods. 
3. Click Save.  

 
The % Value field can be used to apply a percentage amount to all periods. 

 

 

Tip: When creating a new definition, only the settings are copied from the Source Scenario 
to the Target Scenario. If the data needs to be copied to the Target Scenario, you can 
accomplish this by applying an All or Root.Base Member Filter to each dimension in a Rule. 
Example: A#Root.Base, A#ALL. 

 
  



Scenario Analysis 123 Setup Instructions  PV 530, SV 100 

 

Setup   Page 16 of 27 

Copy Rule 
Copying Rules allows for a Rules to be copied to the same Definition Rule Set or different Definition Rule 
Set. 

1. On the Setup page, select the Definition and Rule Set. 
2. Select the Rule you want to copy. 
3. Select Copy Rule. 
4. In the Copy Rule dialog box, add the new Rule Name, an optional Rule Description, Target 

Definition and Target Rule Set. 
5. Click Copy. 

  

Delete Rule 
1. On the Setup page, select the Definition and Rule Set. 
2. Select the Rule. 
3. Select Delete Row(s). 
4. Click Save. 
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Apply Formula to Target Scenario 
Once Rule Sets and Rules are created, the underlying Member Filters and percentage values can be 
applied to the Target Scenario member formula.  

 

The Apply action adds the Member Filters and percentage values from each Rule to the 
Target Scenario member formula.  

 

 
Important! When changing Rule Sets or Rules, you must click Apply in order to apply the 
changes to the Target Scenario member formula.  

When the formula is applied the message, Formula Generated by Scenario Analysis 123 is added to the 
Formula text along with the data and time stamp of update to the Target Scenario member formula 
under Member Properties. 
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EXECUTE 

 
Execute includes the management and execution of Calculation Jobs for scenarios. 

Calculation Jobs 
Allows the ability to execute either a Force Consolidate or Force Calculate data management job for a 
defined set of data for a given Definition scenario. 

 

• Entity: Where a Member Filter can be applied to execute the calculation job for a specific entity. 
• Cons: Where a Member Filter can be applied to execute the calculation job by a specific 

consolidation type. 
• Calculation Type: The type of calculation, Force Consolidate or Force Calculate. 

 

Important! Consideration is needed for the level of Entity hierarchy. Each calculation job 
should only Force Consolidate or Force Calculate for the relevant data set required.  
Example: Force Calculate should be used when there are no parent members, all base, or 
just one base entity.  

• Start Period: The starting period for the calculation job. 
• Periods: The number of periods the calculation job should be executed. 
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Create a Calculation Job 
1. On the Execute page, select the Definition. 
2. Select Insert Row on the Calculation Jobs table header and then double-click in the following 

cells to enter information: 
• Entity: Enter the Member Filters for the Entity dimension. 
• Cons: Enter the consolidation type 
• Calculation Type: Select the calculation type of Force Consolidate or Force Calculate. 
• Start Period: Enter the starting period for the calculation job. 
• Periods: Select the number of periods the calculation job should be executed. 

3. Click Save.  

 

Runs the selected calculation data management job.  

 

 
Important! Make performance considerations before executing calculation data 
management jobs against large metadata hierarchies. 
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ANALYZE 

 

Contains charts and pivot grids to view and analyze different scenarios. 

Filters 
The View and Pivot results are returned when the header filters are fully specified. 

 

View 

 

Provides a chart and grid for Source versus Target Scenario comparison with variance. 
Additional Time, Entity, and Account filters are provided. 
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Pivot 

 

Provides a pivot grid where scenario data can be filtered and analyzed in greater detail. 
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HELP & MISCELLANEOUS INFORMATION 

 
This page contains solution documentation.  

Display Settings 
OneStream XF and XF MarketPlace solutions frequently require the display of multiple data elements for 
proper data entry and analysis. Therefore, the recommended screen resolution is a minimum of 1920 x 
1080 for optimal rendering of forms and reports. 

Package Contents & Naming Conventions 
The package file name contains multiple identifiers that correspond with the Platform. Renaming any of 
the elements contained in a Package is discouraged in order to preserve the integrity of the naming 
conventions. 

Example Package Name: SAM_PV5.3.0_SV100_PackageContents.zip 

Identifier Description 
SAM Solution ID 
PV5.3.0 Minimum XF Platform version required to run solution 
SV100 Solution version 
PackageContents File name 

 

  



Scenario Analysis 123 Setup Instructions  PV 530, SV 100 

 

Help & Miscellaneous Information   Page 23 of 27 

Solution Database Migration Advice 
A Development OneStream XF Application is the safest method for building out a solution with custom 
tables such as this one. The relationship between OneStream objects such as Workflow Profiles and 
custom solution tables is that they point to the underlying identifier numbers and not the object names 
as seen in the user interface. Prior to the solution configuration and to ensure the identifiers match 
within the Development and Production Applications, the Development Application should be a recent 
copy of the Production Application. Once the Development Application is created, install the solution 
and begin design. The following process below will help migrate the solution tables properly. 

See also: Managing a OneStream Environment in the OneStream XF Design and Reference Guide 

1. In the Production OneStream XF application, install the solution and create the data tables. See 
Configure the OneStream XF Application Server for Database Server Connection settings and 
installation details.  

2. Data tables were created in the OneStream XF Development Application during the solution 
installation. Copy the data from the tables to the Production Microsoft SQL Server Database 
using the Microsoft SQL Migration Utility. This utility should only be run by the Microsoft SQL 
Administrator.  

The Microsoft SQL Migration Utility and instructions on its use can be downloaded online from: 
https://sqlazuremw.codeplex.com 

 
Important! This process has the potential to overwrite existing table data in the Production 
Application database if data already exists.  

MarketPlace Solution Modification Considerations 
A few cautions and considerations regarding modification of MarketPlace Solutions:  

• Major changes to Business Rules or custom tables within a MarketPlace Solution will not be 
supported through normal channels as the resulting solution is significantly different from the 
core solution.  

• If changes are made to any Dashboard object or Business Rule, consider renaming it or copying 
it to a new object first. This is important because if there is an upgrade to the MarketPlace 
Solution in the future and the customer applies the upgrade, this will overlay and wipe out the 
changes. This also applies when updating any of the standard reports and Dashboards.  

• If modifications are made to a MarketPlace Solution, upgrading to later versions will be more 
complex depending on the degree of customization. Simple changes such as changing a logo or 
colors on a Dashboard do not impact upgrades significantly. Making changes to the custom 
database tables and Business Rules, which should be avoided, will make an upgrade even more 
complicated. 

 
  

https://sqlazuremw.codeplex.com/
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APPENDIX A: CUSTOM EVENT MODEL 
The purpose of the Custom Event Model is to provide a method in which users can add customizations 
to Scenario Analysis 123 that remain in place and are bypassed during a solution upgrade. Scenario 
Analysis 123 supports these models via Business Rules. 

Set Up the Custom Event Model 
1. On the Application tab click Dashboards > Dashboard Maintenance Units > XFW Scenario 

Analysis 123 (SAM) > Files 
2. In the Files folder, click CustomEventHandler_SAM.zip. 

 

3. In the General (File) pane, click Download File and save the file to an appropriate location. 
4. On the Application tab, click Tools > Load/Extract.  
5. On the Load tab, locate CustomEventHandler_SAM.zip using the Select File icons and click 

Open. 
6. When the file name appears, click Load to import the business rule. 
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Integrate Business Rules 
After importing the business rule, update the SAM_EventHandler business rule to integrate with the 
CustomEvents business rule.  

1. In the General section of the SAM_SolutionHelper script Properties tab, add 
BR\CustomEvents_ScenarioAnalysis123 to Referenced Assemblies. 

 
2. In the General section of the SAM_EventHandler script Properties tab, add 

BR\CustomEvents_ScenarioAnalysis123 to Referenced Assemblies. 

 

3. Comment out line 42 of the SAM_EventHelper business rule.  
4. Uncomment line 43 of the SAM_EventHelper business rule. 

 

 

Once the custom event integration is complete, event actions can be defined in the 
CustomEvents_ScenarioAnalysis123 script.  
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Important! These events will not be deleted or overridden when upgrading to new versions 
of Scenario Analysis 123.However, it is important to reapply these setup steps every time a 
new version is installed.   

Available Custom Events 

Before/After Selection Changed Events 
These events run before/after a custom control is clicked.  

• SaveSettings  
• CreateSolutionTables  
• ValidateSetupStepsExecuted  
• Uninstall  
• OnTableEditorOrGridSelection 
• OnComboBoxSelection 
• OnButtonClick 
• OnShowContentPage 

Before/After Save Data Events 
These events run before/after the save event for a table editor. For example, this can be used to test 
grid data prior to saving and potentially not allowing the data to be saved if a check fails.  

• OnSaveOrUpdateTableEditor 
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